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1 Inleiding 
 

Binnen deze manual is vastgelegd welke stappen moeten worden doorlopen om een nieuw bacnet 
device te koppelen aan wonderware system platform  

 
De opdrachtgever is: 

AMC  

 Meibergdreef 9 

1105 AZ AMSTERDAM 

T: +31 (0)20 56 9111 

 

Rapporteur: 

Industrial HVAC Control Solutions 

 Uraniumweg 49 

3812 RJ AMERSFOORT 

T: +31 (0)33 2999 730 
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2 Algemeen 
 

2.1 Statussen 

Hieronder staan de statussen omschreven die veel in dit rapport terug komen. 

 
Gebruikte definities: 

  

Definitie Uitleg 

  

  

  

  

  

Tabel 1: Gebruikte definities 

2.2 Documenten  

In onderstaande tabel de documenten waar naar wordt verwezen. 
 

Naam Versie  

Wonderware configuratie 
document 

Wonderware configuratie document nieuw bacnet device AMC 
REV 0.3.xlsx 

Aliasname document CSV_Galaxy_dump_Macro_V2.xlsm 

IO templates document UAMC IO-templates_v0.4.xlsm 

  

  

Tabel 2: Referentie documenten  
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2.3 Overzicht te nemen stappen 

Dit document beschrijft het inlezen van de bacnet objecten tot en met het maken van de 
plaatjes op ASP en het overzetten van acceptatie naar productie 
 
Deze handleiding is opgedeeld in de volgende stappen. 
 
Aanmaken op acceptatie 
1 Bacnet objecten inlezen (repository) 
2 ASP objecten genereren van de ingelezen bacnet objecten (repository) 
3 Het configureren van de IO driver (OI server) 
4 Het toewijzen van de ingelezen objecten naar een juiste server en locatie (RDS) 
5 Het opschonen en inkorten van de object namen (RDS Excel) 
6 Het configureren van de objecten passend op de i/o en functies (RDS) 
7 Het configureren van de regelingen en setpunten panes (RDS) 
8 Het verwerken, klaarzetten en configureren van de plattegrond (CDW en RDS) 
 
Overzetten naar productie 
9  
 
 

3 Saia check voor inlezen 
In dit hoofdstuk staat beschreven om de saia voor te bereiden op de export van Bacnet. 
Registreer het bacnet adres wat staat geregistreerd in “bacnet.bnt” bovenaan. 
 
Met het vinkje zet je “linked bacnet” bacnet genereren aan of uit. Check ook de totale telling 
van de bacnet objecten. Bij >1000 dan speciale firmware laden. 
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4 Bacnet device binnen lezen doormiddel van Connexsoft  
 

In dit hoofdstuk is beschreven welke stappen binnen de application generator  moeten worden 
doorlopen om een nieuwe bacnet PLC te kunnen genereren binnen aveva system platform. 
Deze applicatie dient te worden gestart vanuit de repository door over te nemen met radmin. 

 

4.1 Configuratie van de CSX applicatie generator 

 
4.1.1 Instellen CSX applicatie generator  

 
Start de applicatie generator en open de laatste versie instellingen (SIP), “File” > “Open” > 
“Settings”. Kies het juiste bestand en klik “OK”.  
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Figuur 1 Open instellingen CSX applicatie generator  

Als er in de volgende paragraven van dit hoofdstuk instellingen worden aangepast dienen 
deze wijzegingen weer opgeslagen te worden onder een nieuwe versie. (“File” > “Save” > 
“Settings” ) 
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4.1.2 Openen / aanpassen van de namespace settings  

 

Open in de CSX applicatie generator onder “Tools” > “Namespace Settings.  Het dialoog 
vester opent,  
 

 

Figuur 2 Namespace settings CSX applicatie generator  

Selecteer in de namespace settings “Objects” > “Area key map”. In deze lijst moet het 
gebouw, verdieping en systemen die gegenereerd gaan worden bestaan.  Indien deze niet 
bestaan moeten ze toe gevoegd worden. 
 
In het excel bestand wonderware configuratie document onder tab project informatie is deze 
info te vinden.  
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Het toevoegen van nieuwe gebouwen, verdiepingen en of systemen werkt als volgt, klik in de 
namespace settings rechts bovenin op het blauwe plus teken.     

 

Figuur 3 toevoegen area keymap  

In het bovenstaande figuur is met nummers aangegeven welke velden ingevuld dienen te 
worden, in de onderstaande tabel staat per nummer aangegeven wat er ingevuld moet 
worden. Als de gegevens zijn ingevuld moet er bevestigd worden met “OK”. 

Let op: De Templates voor een systeem moeten bestaan binnen Aveva system 
platform, Neem contact op met de beheerder van het scada systeem voor het 

aanmaken van deze template.  

  

Nr. Gebouw: Verdieping: Systeem: 

1 Gebouwnaam  Verdiepingsnaam Systeem naam volledig met middenstreepje  

2 Gebouwnaam  Verdiepingsnaam Systeem naam volledig met underscore 

3 1 2 5 

4 $BacA_Building $BacA_Floor Systeem template “$BacA_SYSTEM_???” 
(de vraagtekens zijn de 2 of 3 letters van de systeem naam)  

5 aan uit aan 

Tabel 3: Area keymap  
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4.1.3 Controleren / aanpassen Archestra settings 

Om zeker te weten dat de applicatie generator de PLC naar de juiste server en engine gaat 
genereren, moeten er instellingen worden gecontroleerd. Ga in de Application generator naar 
“Tools” > “Archestra settings”. 
 

 

Figuur 4 Openen Archesta settings  

In het excel bestand wonderware configuratie document onder tab “wonderware info” is te 
vinden op welke OI server(‘s) de communicatie naar de PLC gemaakt moet worden.  
 
Als er een redundante server is ingevuld moet in onderstaande figuur “Enable DI object 
redundancy aangevinkt worden”.  Als de redundatie aangevinkt is dient de DI object name 
decoration ingevuld te worden. In de prefix worden de 4 cijfers uit de server naam ingevuld 
met een underscore op het eind.  De append is een underscore met de volgletter van de 
server vaak A of B. 
 

 

Figuur 5 Archestra settings Redundancy  
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In de archestra settings > Port objects wordt de DDESL / OPC client name ingevuld,  Als 
redundantie is ingeschakeld is dit alleen “Bacnetclient_” als de redundatie is uitgeschakeld 
worden de 4 cijfers in de servernaam toegevoegd.   
 
Note: bij selecteren ‘Enable DI object redundancy’ dient de suffix van de DDESL/OPC 
clientname handmatig verwijdert te worden. I.e. ‘Bacnetclient_2510’ word ‘Bacnetlcient_’. 
 

 
 

Figuur 6 Archestra settings Port objects   
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4.2 Bacnet device generen met de applicatie genereren  

4.2.1 Nieuw bacnet device toevoegen in de applicatie generator 

 
Ga in de applicatie generator naar “File” > “Preconfigured devices”. 

 

Figuur 7 Openen pre-configured devices  

Klik op het blauwe plusje en vervolgens op “Add manually”. 

 

Figuur 8 toevoegen area keym 

In het excel bestand wonderware configuratie document onder tab project informatie is te 
vinden welk device id en netwerk adress de plc heeft, vul deze in en klik op “Test”.  

 

Figuur 9 Configureer device adres  

 Klik als de ping test slaagd klik dan op “OK’ het device is nu opgeslagen  
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Als de Ping test niet slaagd en het device is wel online in het veld, bel dan de ICT 
helpdesk van het AMC om te vragen of ze de routering goed willen zetten.  

 

Figuur 10 Ping test nieuw device   

4.2.2 Scannen van het bacnet device  

 
Klik op de scan button  
 

 

Figuur 11 Scan bacnet   

Klik op expert mode (dit venser komt alleen de eerste keer na opstart van de applicatie 
generator) 
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Figuur 12 Scan bacnet selecteer expert mode  

In de Bacnet connection options wordt het locale IP adress van de server ingevuld,dit is het IP 
van de machine waar de applicatie generator op is geopend. Zet het scanfilter gelimiteerd op 
de devices die generereerd moeten worden dan gaat het scannen iets sneller.  

 

 

Figuur 13 Bacnet scan opties   

 
Klik op “OK” het scannen wordt nu gestart.  
 

Let op: het kan gebeuren dat er niets gescant word, probeer het dan gewoon nog 
een paar keer. Soms gebeurt het dat device niet snel genoeg reageerd.  

Na het scannen komen de Bacnet punten in de linkerkolom te staan, zoals hieronder te zien 
is. Als er niks te zien is zorg er dan voor dat de object en device filters uit staan.  
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Figuur 14 Bacnet scan   

4.2.3 Genereren van bacnet objecten  

 
Klik op genereer bacnet objecten.  
 

 

Figuur 15 Genereer bacnet objecten  
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Controleer of de juiste galaxy is ingevuld (welke galaxy actief is kan je zien rechts onderin de 
IDE). 
Vink voor de rest dezelfde punten aan als in de afbeelding hieronder. 
 
 

 

Figuur 16 Genereer opties. 

Note: de galaxy kan indien nodig worden aangepast door op het hoofdscherm naast 
de galaxy name op het pijltje te drukken. 

 

Let op: Zorg dat alle templates binnen de IDE zijn gesloten en ingecheckt  

Klik op “OK” het genereren zal nu starten 
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Na het genereren krijg je de volgende popup. Selecteer ‘No’. 
 

  
 
Het kan zijn dat er gebrekkige codes zijn ontstaan in objecten, zie afbeelding hieronder. Dit 
kan 2 oorzaken hebben: 
 
1. Er zijn typefouten gemaakt in de software van de PLC waardoor de bacnet coderingen niet 

kloppen. 
2. Er zijn object codereringen gebruikt waar nog geen templates voor zijn, overleg hiervoor 

met Scada beheer van het AMC. 
 

 

Figuur 17 Controle gegenereerde objecten  

 

4.3 Configuratie IO driver  

Open de OI server, met de RDS kan je de locatie wel benaderen maar niet bewerken. 
 

 
 

Open de SMC op de OI server waar de zojuist gegenereerde PLC op moet gaan draaien.  

 

Figuur 18 Open the SMC  
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Selecteer de conneXsoft driver  > Rechtermuisklik op BACnet IP > Klik “Add BACnet Device 
connection”. 

 

 

Figuur 19 Voeg een bacnet connectie toe  

Geef de connectie de vollgende naam : “Dev” + Bacnet device ID 

  

Figuur 20 Device connectie parameters.  

Vul zoals aangegeven in bovenstaande afbeelding Het device ID en IP adress van de PLC in.  

 

Figuur 21 Toevoegen scangroup   

Selecteer “Device groups” > Rechtermuisklik in de tabel > Klik “Add”.  
 
Vul onder “Name” de naam van de scangroup in, deze wordt als volgt opgebouwd:  
“Dev”+Device ID+”_SG1”  
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Figuur 22 Scan groups bacnet connectie  

De DAS bacnet server is nu klaar voor gebruik, bij een redundante server dienen 
bovenstaande staande stappen nogmaals te worden uitgevoerd op de redundante partner.  
 
 
Sign out van de OI server. 
 
Log in op de RDS en als laatste stap dient de bacnet client worden gedeployed. 
 

 

Figuur 22 deployen  
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5 Configuratie binnen wonderware system platform 
 

Start de RDS server 

5.1 Server configuratie 

Start de IDE als administrator en log in. 
5.1.1 Objecten asignen aan de juiste area  

Open de Deployment view in de IDE (Repository server), Kijk in de “unassigned host” hier 
zullen de zojuist gegenereerde objecten staan. 
 
In het excel bestand wonderware configuratie document onder de tab ‘wonderware informatie’ 
is te vinden onder welke applicatie server de objecten moeten draaien.  
  
Selecteer de objecten en sleep deze naar de juiste applicatie server door te selecteren en te 
slepen om vervolgens los te laten op het engine icoontje 
 

Let op: Het slepen van objecten naar een bepaalde locatie kan alleen als deze 
undeployed zijn !! 

 
 

 

Figuur 23 Unassigned host assignment  

 

Figuur 24 Deployment view Applicatie server  

 
Ga nu naar de model view en sleep de objecten onder “Hospital” 
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Figuur 25 Model view  

5.1.2 Bacnet client toewijzen  

 
Ga naar de deployment view, sleep indien deze er nog niet staat de bacnet client onder de 
app engine van de juiste server zoals omschreven in het exel bestand wonderware 
configuratie document. Deze stap is normaliter niet nodig ga verder met 5.2. 

 

 
Figuur 26 Bacnet client deployment view  
 
In de model view dienen de bacnet clients in het mapje “AMC_OI_Servers” te staan. Sleep 
deze hierheen indien nodig.  

 

Figuur 27 Bacnet client model view   
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5.2 Object configuratie  

 
5.2.1 Generen van alias namen  

Selecteer alle objecten na alles open te klappen van het project en exporteer deze als galaxy 
dump naar de map C:\new folder.  Start CSV_Galaxy_dump_macro_V2 
De Excel voor de import lijkt niet vanaf elke pc te werken. Vanaf de ihcs laptop gaat het goed. 

 
in het Aliasname document staat op het eerste tabblad omschreven hoe de data 
geexporteerd en geinporteerd moet worden. 
 
 
5.2.2 Opschonen objecten zonder functie 

Na het genereren in de vorige stap is in de deployement view een meer overzichtelijk lijst 
ontstaan. De codering is ingekort. In deze stap kan worden gecontroleerd of niet herkenbare 
objecten staan door bijvoorbeeld het missen van objecten in de standaard maar er zijn ook 
een aantal objecten die kunnen worden verwijdert.  
 

 
 
In de bovenstaande afbeelding kunnen de blauw geselecteerde objecten kunnen worden 
verwijdert. Daarnaast kan je zien dat objecten eventueel niet goed zijn doordat ze ontbreken 
zoals de QT (luchtkwaliteit) 
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5.2.3 Regelkast maintenance melding aanmaken 

Binnen deze paragraaf wordt besproken welke dingen er geconfigureerd moeten worden op 
regelkast niveau.  
 
Ieder systeem heeft een onderhouds alarm, om deze ook in de alarm lijst zichtbaar te maken 
moeten ze met de hand aangemaakt worden op regelkast niveau. Ga in de deployment view 
naar de zojuist gegenereerde regelkast. 
 

  
Figuur 31 Regekast niveau 

 
Open het regelkast object, in dit object is al een alarm punt aanwezig 
“RK001_01_MAINTENANCE”. Dubliceer dit alarm 1 keer voor ieder systeem dat onder deze 
regelkast valt dus inclusief het regelkast proces zelf. 
 

 
Figuur 32 Regekast niveau onderhouds alarm 
 
Geef de zojuist aangemaakte alarmen de systeem naam + “_MAINTENANCE” . De naam 
moet correct zijn ,het alarm wordt namelijk getriggerd vanuit een script op systeem niveau. Bij 
typfouten of als de alarm instellingen worden aangepast kan het alarm mogelijk niet werken. 
 

 
Figuur 33 Regekast niveau nieuwe onderhouds alarmen 
 
 
Het regelkast object is nu geconfigureerd en kan opgeslagen en gesloten worden. 
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5.2.1 IO Objecten configureren 

 
De gegenereerde objecten moeten nog geconfigureerd worden. Door alle gegenereerde 
objecten in de boom open te klappen en indien nodig de containers te openen.  In de 
containers zijn choices en options gemaakt om de juiste functionalliteit te kunnen selecteren. 
In het IO templates document is voor iedere tempate te vinden welke mogelijke opties er zijn 
en welke io opjecten daarbij horen. 
 
Configureer de objecten door deze naast het regelschema te leggen en juist in te stellen. 
Welke i/o is aanwezig en hoe ziet het symbool er grafisch uit. 

Let op: Laat alle objecten uitgeklapt staan  

De selectie van de aanwezige hardware i/o punten kan worden geselecteerd zoals in 
onderstaande afbeelding aangegeven. 
 

 

Figuur 42 Container opties algemeen 

Selectie van stuur signalen gaat door middel van het pull down menu 
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5.2.1.1 Instellen algemene meldingen zonder grafisch symbool 

 
De meldingen die niet grafisch object zijn terug te vinden zoals de regelkast meldingen dienen 
te worden geconfigureerd in het niveau van de software assets zoals de A1 melding. Dit is 1 
niveau lager dan het object container niveau.  
 

 

 

5.2.1.2 Configureren van SPD objecten 

 

Bij het instellen van de temperatuur opnemers is het van belang te weten dat alleen setpoint met 
adjustment wordt geselecteerd  als temperatuurmeting is gekoppeld aan een enkele setpunt maar 
er is wel een offset instelmogelijkheid beschikbaar. Er dient heating curve 2p te worden 
geselecteerd wanneer de temperatuur opnemer de meting is voor een stooklijn instelling. 

Een SPD dient per object te worden ingesteld door dubbel op het object te klikken. 
Er zijn een aantal varianten mogelijk ; 

 
type omschrijving Soort spd 

Heating Curve 2P Stooklijn 2 werkpunten Retourtemperatuur 
weersafhankelijk 

Heating Curve 4P Stooklijn 4 werkpunten Geen voorbeeld. 

Setpoint determination Setount met minimaal en 
maximaal met weging 

Geen voorbeeld. 

Single setpoint Enkel setpunt Alleen een setpunt zoals een 
luchtklep minimale stand 
instelling 

Setpoint adjustment Enkel setpunt met afwijk  
stelmogelijkheid 

Inblaas druk met verstelling. 

Sp adjustment + nacht offset 2 setpunten Inblaas druk met nacht en 
verstel mogelijkheid 

NO TYPE geen Standaard instelling, geen 
zichtbaarheid 

 
 

5.2.1.3 Metingen van het weerstation 990 objecten 

In de regelkast zijn diverse objecten van het weerstation in de codering aangeduid als 990 
serie. Deze dienen allen als geen wsp te worden ingesteld. 

 

5.2.1.4 Instellen centrale functies 

Alle centrale functie objecten verwerkt in het proces dienen te worden ingesteld als system. 
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Voorbeelden hiervan zijn de objecten: CDB, CKAL, CBS, 

Wanneer de instelling moet worden gedaan van de CFGR (gebouwregelaar) dan dient de optie 
“building” te worden geselecteerd. 

Uitzondering hierop is de preferentie schakeling. Hierbij zijn 2 verschillende selecties mogelijk. 
hw_symbol als er hardware i/o aanwezig is zoals de preferentiecontacten aangsloten in de rk 
no_hw_symbol als het software meldingen zijn en weergave of selectie van die instelling 

Daarnaast is dus een 2de selectie om aan te geven op welk niveau de data van toepassing is. In het 
systeem dus selectie systeem. 

 

In het regelkast proces zijn er 3 objecten voor de noodstroom te weten: 

-eps000  No-hw-symbol cabinet 

-eps001 Hw-symbol none 

-eps002 Hw-symbol none 

 

 

In deze fase van configureren worden alle loops overgeslagen. 
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5.3 PID Configureren 

Voor ieder systeem binnen een regelkast dient een PID gemaakt te worden. In de komende 
paragraven staan de stappen omschreven die uitgevoerd moeten worden per PID de stappen 
zullen dus een aantal keer herhaald moeten worden.  

 
 

5.3.1 PID Symbool aanmaken   

Na het configureren van de objecten is het tijd om de PID te gaan bouwen. Ga naar 
“AMC_Specific_Content” > “3. PID’s” > “3.0 Default” > “Default”. Dubliceer dit symbool. 

 

 
Figuur 43 Dubliceren default PID  

 
Geef het gedubliceerde symbool de volgende naam “Gebouw + Verdieping + Systeemnaam”. 
Sleep het symbool vervolgens onder het juiste gebouw/verdieping. Indien de folder nog niet 
bestaat kan deze aangemaakt worden door met een rechtermuisklik op de structuur te klikken 
en vervolgens “New> Graphic Toolset” te klikken zoals onderstaande afbeelding.  Hetzelfde 
geldt voor het maken van vloeren. Als men met onvoldoende rechten is ingelogd loopt de 
rds vast bij het omnoemen van het pid plaatje. 
 

 
 
Figuur 44 maken nieuw bouwdeel 
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Figuur 44 hernoemen PID Symbool.  

 
Herhaal het bovenstaande voor ieder systeem binnen de regelkast.  
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5.3.2 PID bouwen  

Een PID bouwen binnen system platform word atijd gedaan aan de hand van een 
aangeleverde en goedgekeurde  PID.  
 

5.3.2.1 Werken met lagen 

 
Het is mogelijk om in de grafische editor met lagen te werken. Dit kan handig zijn doordat de 
elementen erg groot worden weergegeven. Het is mogelijk om zelfstandig lagen toe te voegen 
maar er staan standaard al een aantal lagen ingevuld. 
 
De elementen dienen per project in de juiste laag te worden gesleept om hiermee te werken. 
Dit kan worden gedaan door de elementen vanuit de “elements naar de “layers(1) te 
slepen”(3). Kies hiervoor de jusite laag zoals omschreven.  
 
0: Assets voor de grote objecten zoals de verwarmer, bevochtiger enz.. 
1: Transmitters voor de elementen 
8: lines voor het plaatsen van al het tekenwerk  
9: background voor de achtergrond. Deze is standaard al geplaatst. 
 
Door middel van het indrukken van het oogje zet je de laag aan of uit. (2) 
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5.3.2.2 Tekenen van het PID plaatje 

 
In de meeste gevallen is een bestaande pid afbeelding het uitgangspunt van het nieuw te 
maken pid plaatje. Na de kopieer actie is onderstaande afbeelding het resultaat bij het openen 
van de afgeleide PID afbeelding door dubbel klik. 
 

 
Figuur 45 Voorbeeld van kopie afbeelding welke het startpunt is voor het op maat maken. 
 

Als de tekening van de PID veel overeenkomsten heeft met het voorbeeld, dan kan worden 
volstaan door de nieuwe symbolen over de oude niet gekoppelde symbolen te plaatsen. Dit 
kan helpen voor het goed plaatsen van de symbolen. Wanneer het proces wezenlijk anders is 
dan is het raadzaam om eerst de oude symbolen te verwijderen en de tekening aan te passen 
om daarna de nieuwe symbolen te plaatsen. 
 
 
 
 

 
Ga in de toolbox naar ‘AMC_Design_Content’ > ‘PID_Content’ hier zijn de symbolen te vinden 
om de PID mee te bouwen,  selecteer een object en sleep deze naar het canvas. 
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Figuur 45 Content locatie voor PID  

 
Met de tab properties kunnen nadat een teken element is geselecteerd de instellingen worden 
aangepast zoals van een solide naar een stippel lijn of het medium. 
 

 
Figuur 46 Instellingen van het (teken) object  

 
Navigeer in de assets naar het juiste systeem en sleep de assets naar de juiste plek in de 
PID. 

 



 
  

U-AMC HVT 
 

AMC wonderware 
 

Document No. : 001 

Project No. : 20200366 

Date  : 15-4-2021 

Rev. : 0.1 

Author : M. van Dijk 

Page : 33 of 55 
 

 

 

Document: Bacnet device scada implementation user manual Status:  REV 2.0 
 

 

 
Figuur 47 Asset locatie voor PID  
 
Door op het canvas de zojuist ingesleepte asset te selecteren en op properties te klikken zijn kunnen de 
aanvullende instellingen zoals de rotatie worden ingesteld.  

 
 

 
 
Figuur 47 Asset instellingen  
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Herhaal bovenstaande voor alle objecten binnen het systeem en vervolgens voor alle PID’s binnen de 
regelkast. 
 
Deploy hierna de objecten en de vieuwapps de regelkast is nu klaar voor gebruik.  
 
 
 

5.3.2.3 Koppelen van het PID plaatje aan het object. 

Open het proces object en ga naar de tab attributes. Klik de knop link content aan  
Selecteer het gemaakte PID plaatje. Nu is het pid plaatje gekoppeld aan het object van het proces. 

 
 

Figuur 48 gekoppeld pid proces plaatje aan het object  

 
5.3.3 Loops en SPD’s maken 

 
Binnen de meeste systeemen worden regelingen gebruikt deze worden aangeduid met 
opjectcode “LOOP” of “SPD”.In SIP is ingevuld welke regelingen er zijn per systeem en welke 
opnemer wordt gebruikt voor de regeling of SPD. 
 
Voordat wordt begonnen met het configuren is het voor het overzicht noodzakelijk om een lijst 
te maken met loops en het vaststellen van een volgorde. De standaard volgorde is om in de 
stromingsrichting van het gemaakte medium ook de volgorde van de spd’s en loops weer te 
geven. Daarbij is nog wel van belang om dit per regeling te doen. Bijvoorbeeld 
inblaastemperatuur zowel de wtw, verwarmer en koeler na elkaar op te schrijven en niet 
bijvoorbeeld een drukregeling er tussen te zetten. In SIP zou dit ook als zodanig in de 
volgorde moeten staan. 

 

5.3.3.1.1 Stap 1: Maak een regelingen pane aan 

Open het systeem en voeg een nieuw symbool toe. Geef het symbool de naam “Loops”. 
 

 
Figuur 34 Loop pane symbol  
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Dubbel klik op het nieuw aangemaakte symbool om het tekenblad te openen. 
Geef het aangemaakte symbool content type “User_Defined_2 “.  

 
 
Figuur 41 Designer preferences  
 

 
Controleer voor je verder gaat of de snap to grid aanstaat en of de 
preferences goed staan.  
 

  
 

     Figuur 42 Designer preferences  
 
 

 

5.3.3.1.2 Stap 2: Toevoegen van het knoppen symbool    

Nu het Loop symbool aangemaakt is kan deze geconfigureerd worden, Sleep uit de toolbox 
het symbool “System_loop” op het canvas. 
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Figuur 36 Toevoegen regelingen knoppen   

5.3.3.1.3 Hoeveelheid loops in het symbool selecteren 

 
Tel het aantal loops in het systeem op.  
Klik in de grafische editor van het symbool loops het eerder gemaakte symbool aan (1)  en klik 
op properties (2). Standaard staat onder wizard options 4_6 loops uit (3). Deze en 
aanvullende regels moeten op true worden gezet (4) afhankelijk van het aantal regelingen.  

 
 

 
 
Figuur 36 instellen symbool regelingen   
 

 

5.3.3.1.4 Stap 3: Toevoegen regeling symbolen 

Zoek in de assets de loops van het systeem op en sleep ook deze op het canvas.  
Zorg ervoor dat het grafisch mooi onder de regelingen selectie knop staat. 
Sleep alle loops op het blad precies over elkaar heen. 
 

 
 

Figuur 37 Toevoegen regelingen panes   
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5.3.3.1.5 Stap 5: Configureren knoppen symbool 

 
Het aantal toegepaste regelingen moet worden ingesteld bij CustomProperties. In 
onderstaande screenshot staat nog 1, dit dient nog te worden aangepast in 10 (1) 
 
 Bij de properties onder “custom properties moeten nu de regelingen aan de knoppen worden 
toegevoegd. Hiermee wordt de volgorde van de knoppen bepaald en gekoppeld.” 
“Bij de BTN_Name moet voor iedere regeling de description tag worden ingevuld. (zie 
screenshot) (2) 

 
 
Figuur 40 Instellen regelingen knoppen 

 

5.3.3.1.6 Stap 4: Configureren regelingen symbolen 

 
voeg zoals in onderstaand figuur de visibility animatie toe, De Expressie is : 
System_Loop1.BTN == (Knopnummer). Knop 1 =1 2=2 enz. 
 

 
 
Figuur 39 Instellen visibility Regeling symbolen  
 
Als hulpmiddel kan bij de elements vieuw worden gezien welk object is gekoppeld door de verandering 
van het symbool. 
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5.3.3.1.7 Stap 6: uitlijnen 

Lijn alle regelingen uit recht onder de knoppen, let er op dat re geen overlap is tussen de 
knoppen en de regeling symbolen. 

 

Figuur 41 Uitlijnen regeling symbol   

Het symbool is nu klaar en kan opgeslagen en gesloten worden. 
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5.3.4 Setpunten pane maken 

Het maken van deze pane is identiek aan het maken van de pane regelingen alleen het 
maken van het object heet “Setpoints” 
 
Tevens dient na dubbel klik op het nieuwe object de contentType op User_Defined_4 te 
worden ingesteld. 
 

 
 

 
Het configureren van het loop selectie symbool is hetzelfde als bij loops alleen de benaming is 
anders. Zie onderstaande screenshot als voorbeeld.  
J_LBTA001_01_SPD_194_01.SP1.DESCRIPTION 
 

 
 
 

 
5.3.5 Plattegrond aanvragen en verwerken 

Er zijn afspraken gemaakt met HVT gegevensbeheer hoe de navigatie plattegronden worden 
aangeleverd. 
Samengevat: 
 
-kleuren zwart wit 
-A0 formaat 
-schaal 1:120 
-zonder kader 
-met stramienen 
-met ruimtenummers 
-met trappen en liften 
 
 
De aanvraag kan worden gedaan via de volgende link: 

 
https://forms.office.com/r/66GFC86G0w  
 
-Selecteer in het formulier voor de discipline 20 (BK) 
-Aanleveren als PDF 

https://eur04.safelinks.protection.outlook.com/?url=https%3A%2F%2Fforms.office.com%2Fr%2F66GFC86G0w&data=05%7C02%7Cl.t.vanbergeijk%40amsterdamumc.nl%7C194db83c496347a303d408dd41d4a7c0%7C68dfab1a11bb4cc6beb528d756984fb6%7C0%7C0%7C638739103773222594%7CUnknown%7CTWFpbGZsb3d8eyJFbXB0eU1hcGkiOnRydWUsIlYiOiIwLjAuMDAwMCIsIlAiOiJXaW4zMiIsIkFOIjoiTWFpbCIsIldUIjoyfQ%3D%3D%7C0%7C%7C%7C&sdata=9czQTvwfrnAVrXgJYXcSgdnhqtnsES5ZOSg5oK%2FyBGg%3D&reserved=0
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Wanneer de plattegrond is geleverd, dient deze te worden geopend met Adobe Acrobat niet 
de reader. S 
 
De tekening dient te worden opgeslagen als een .png. 
 
De zojuist geopende PNG dient te worden geopend met Paint.  
Selecteer de plattegrond zodanig dat de stramienen worden geselecteerd maar het witte vlak 
er om heen niet. 
 
De volgende stap is om de afbeelding in dien nodig te verschalen. 
De maximale hoeveelheid pixels in ASP is Width 4056 x Height 3780 
De verschaling kan worden uitgevoerd met functie formaat wijzigen (1). 
Vervolgens dient een percentage te worden ingevuld (2).  
Het aantal pixels in uit te lezen in de onderbalk. 
 

 
 
 
 Sla de afbeelding weer als PNG op. 
De locatie van opslag dient een gekoppelde schijf te zijn waar de RDS ook naar kijkt. Dit kan 
worden ingesteld in de instellingen van remote desktop. Zie onderstaande screenshot. 
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5.3.5.1 Nieuw bouwdeel en vloer plattegrond toevoegen aan de grafische omgeving. 

 
Als er een nieuw bouwdeel moet worden toegevoegd omdat deze nog niet bestaat binnen de 
omgeving dan ga je naar de “graphic toolbox”, klik op “floor” “New” “grafic Toolset.” 
Hernoem de mapnaam naar het gebouw zoals de overige bouwdelen 

 
 

 
 
Dupliceer een plattegrond object van een bestaand bouwdeel en hernoem deze. Sleep de 
hernoemde kopie naar het juiste bouwdeel. 
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Open het hernoemde en verplaatse object.  
Verwijder de plattegrond van het bouwdeel waar vanaf gekopieerd is.  

Klik bij tools image  aan. 
Zoom uit en sleep een zo groot mogelijk wit vlak op het tekenvel. Hier zit de maximale schaal 
aan van Width 4056 x Height 3780 
 
Importeer de voorbereide plattegrond in de afbeelding en sla deze op. 
 
Als een nieuw bouwdeel is toegevoegd dan moet de boom worden aangemaakt.  
Dit doe je door in de graphic toolbox naar amc graphic content> 2.2.2 floors_menu_nav_BWD 
 

  
 
Daar dient en kopie te worden gemaakt van een al bestaand gebouw, pas de naam aan en 
dubbel klik op het nieuwe object. Klik de nav_pane aan en pas navgation start node aan bij de 
properties naar het juiste bouwdeel.  
 
Hierna is de nieuwe boom gemaakt en dient alleen de view clients te worden gedeployed. 
 
 

5.3.5.2 Gebouw 

Op gebouw niveau hoeft niks geconfigureerd te worden. 
 

 

5.3.5.3 Verdieping 

Binnen deze paragraaf wordt besproken welke configuratie er gedaan moet worden op 
verdieping niveau. 
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Open het verdieping object en open vervolgens uit de content de floor mapping.   
 

 
Figuur 28 Vloer content verdiepings niveau 
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Als het plattegrond symbool geopend is navigeer dan binnen “Assets” naar de zojuist 
gegenereerde systemen.  Sleep voor ieder systeem het “Cards_Cabinets” symbool in de 
plattegond. 
 

 
Figuur 29 Systeem knoppen toevoegen verdiepings niveau 
 

Positioneer de knoppen binnen de platttegrond op het juiste quadrant, het quadrant kan je uit 
de tagcode halen voor de regelkast. Voor de processen is de juiste locatie aangegeven in SIP 
of de Saia software 
De tag codes zijn als volgt opgebouwd: Gebouw_Verdieping_Quadrant, in onderstaande 
figuur is het quadrant dus X03Y0L. 
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Figuur 30 Systeem knoppen plaatsen in plattegond verdiepings niveau 

 
De plattegrond en het verdierping sybool kunnen nu opgeslagen en gesloten worden.  
 

5.3.5.4 Quadranten 

Binnen het quadrant niveau hoeft niets geconfigureerd te worden.  
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5.3.1 Opnieuw inlezen van objecten na mutaties Saia 

Wanneer In de Saia de software opnieuw is gecompileerd en de bacnet lijst is aangepast dan 
dient deze ook opnieuw te worden ingescand en gegeneerd. De reden hiervoor is omdat de 
bacnet koppeling in Connexsoft op basis van bacnet adressen plaatsvindt en deze wijzigen bij 
opnieuw compileren. 
 
Wanneer objecten opnieuw worden ingelezen is het belangrijk te weten dat oude objecten die 
niet meer aanwezig zijn, niet worden verwijdert door Connexsoft. Dit moet met de hand 
worden verwijdert. Dit is noodzakelijk omdat oude bacnet adressen wel blijven bestaan en dit 
tot fouten kan leiden omdat het bacnet adres blijft bestaan in ASP welke een ander adres kan 
zijn. Een manier om dit te zien is de niet veranderde objecten na te lopen na het opnieuw 
genereren. Uitzonderingen op dit laatste is de Sys objecten en de klok objecten. Deze 
veranderen nooit van symbool na opnieuw genereren.  
 

5.4 Narooiwerk objecten/storingsanalyse bij fouten 

Als er na het genereren van de boom in ASP fouten zichtbaar worden door de symbolen
dan liggen de onderstaande oorzaken voor de hand; 
 
- Coderingsfouten in Saia (teksten) 
- Verkeerd gemuteerd in ddc suite blokjes 
- Verkeerd geconfigureerd in ASP (selectie functies objecten) 
- Het inlezen met connexsoft is niet goed gegaan. 
 
5.4.1 Coderingsfouten in Saia 

Het is zeer belangrijk en het meest effectief om de objecten in 1x goed in te lezen. Dit is de 
meest effectieve en eenduidige manier. Het is daarom aan te bevelen om na afronding 
engineering alle bacnet blokjes na te zien op de codering. Daarnaast ook na het genereren 
van de Bacnet lijst ook deze te controleren op de juiste coderingen. 
 
5.4.2 Verkeerd gemuteerde ddc blokjes 

Uit de standaard software nooit ddc blokjes verwijderen. Uitgangspunt is dat deze allemaal 
nodig zijn en standaard juist zijn ingesteld. Niet ieder ddc blokje wordt gebruikt in ASP. In dat 
geval staat bacnet uit. 
 
5.4.3 Verkeerd geconfigureerde objecten in ASP 

Als de objecten zodanig zijn geconfigureerd dat dit niet overeenkomt met wat in Saia is 
gemaakt dan missen er datapunten en treden er fouten op. De Excel kan worden geraapleegd 
(WSP UAMC IO-Templates)voor de juiste configuratie of andere voorbeelden van ASP. Deze 
kunnen grafisch naast de geselecteerde functie worden gelegd.  
 
 
5.4.4 Verkeerd symbool. 

Bijvoorbeeld een ventilator wordt als pomp weergegeven. Dit is een bug in ASP. Er kan 
worden gekozen alle gebruikers uit te loggen op de rds en deze opnieuw deployen, of het 
symbool te valideren. Dit laatste is een actie om opnieuw het symbool te koppelen. 
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5.4.5 Het inlezen met connexsoft is niet goed gegaan 

Het kan voorkomen dat grote stations met veel bacnet objecten of bij het opnieuw genereren 
van symbolen dit niet in 1x goed gaat. Voor grote stations kan het helpen om per systeem 
objecten te genereren en als het niet in 1x goed gaat is het zaak om de actie te herhalen. Dit 
vooral bij veel wijzigingen. Zoals ook eerder vermeld is het belangrijk goed zicht te hebben 
van de veranderingen en objecten waarvan geen actueel bacnet object meer voor is met de 
hand te verwijderen. 

 

6 Genereren van enkele deel devices (filter) 
 
Eerst dient de bacnet lijst van het device id te worden ingelezen. 
Daarna kan er een deel generatie worden gedaan door een filter aan te leggen zoals onderstaande 
screenshot. In dit voorbeeld is een filter aangelgd op het afzuig systeem en daarna een drukverschil 
meting. 
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7 Project van acceptatie naar productie verplaatsen 
 
 
 
 

7.1 Export vanaf de acecptatie 

 
Open een sessie vanuit radmin met de SRVA_wonderware inlog (zodat je rechten heb om bestanden 
uit te wisselen met Productie). 
 
Selecteer alle over te zetten objecten door deze allemaal open te klappen. Het handigst is om dit van 
onder af naar boven toe te werken. 
 
Klik met de rechter muis op de geslecteerde objecten en kies “Galaxy dump” 
 

 
 
Kies onderstaande locatie waar je goed bij kan vanuit de acceptatie en maak een mapnaam op basis 
van de regelkast waar de galaxy dump en de plattegrond in komt te staan. 
 
Z:\Overzetten_prod\ (naam van de regelkast) 
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Exporteer de plattegrond “export>objects” en sla deze op in de zelfde map als de galaxy dump. 
 

 
 
 

7.2 Inporteren op de productie omgeving 

 
Start de productie repository op via Radmin. 
Start de IDE op met admin rechten (SRV) ipv (SRVA voor de acceptatie) 
 
Ga naar de bovenbalk>Galaxy>import> Galaxy load 
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Ga naar de locatie E:\wonderware\overzetten_prod en selecteer het juiste .csv bestand. 
 
Het systeem vraagt hoe met mogelijke conflicten om te gaan. 
Kies “only update chacged attributes” 
 

 
 
Importeer de plattegrond structuur. 
Ga naar de bovenbalk>Galaxy>import> 
 
Laat de instellingen staan zoals standaard en in onderstaande screenshot aangeven 
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Selecteer de geimporteerde objecten en sleep deze naar de engine  
 

 
 

 
 
 
 

7.3 IO server inrichten op productie 

 
Ga naar de i/o server die niet actief staat met behulp van Radmin. 
 

Start platform management  
 
Open de boom conform screenshot en klik op “Add BACNetDevice Connection” 
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Vul de juiste device naam bij de nieuwe regel en in de instellingen. 
Vul het juiste ip adres in door op het vierkantje te klikken naast de Device ID 
 

 
 
 
Maak bij de tab Device groups ook het divice aan. Dit doe je door op het veld met rechtermuis “add” 
te klikken. 
 

 
 

Deploy de i/o server op vanaf de IDE  
 
Ga naar de i/o server en Deactivate de communicatie en start hem daarna weer op door “activate 
(auto sart after reboot)” 
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Herhaal deze procedure op de andere bacnet server. 
 
Vervolgens moeten op de repository de nieuwe devices bekend worden gemaakt door de devices 
aan te maken (scan-groups) in menu-item topic na dubbel klik op  de IO servers. Dit dient ook te 
worden uitgevoerd op het cluster. 
Als laatste stap dienen de bacnet clients (de IO servers) en het cluster te worden gedeployed. 
 

 
 
 
 

 
 
 
 
Deploy op de AOS a de geimporteerde Galaxy 
Hiervoor moeten alle objecten volledig worden geopend. 
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Vervolgens moet (indien nog niet aanwezig) de verdieping-navigatie en de plattegrond worden 
overgezet. 
 
Navigatie verdiepingen exporteren als object: 
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Hetzelfde voor de plattegrond: 
 

 
 
 
 
Deze objecten importeren in Produktie galaxy. 
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